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PARTNERS

I&F based in Dublin, focuses on educational development for individuals of
all ages, particularly in the fields of entrepreneurship, sports and personal
development, youth, language acquisition, inclusion, diversity, and rural
development. We emphasize lifelong learning and adult education.

Forum Educativo is a Spanish organization in Seville, specialising in
education and training across various fields like entrepreneurship,
disabilities, adult education, youth, languages, social inclusion, and rural
development. 

The Valentín de Madariaga Foundation aims to promote the social inclusion
of people with disabilities. They established SIES in 2003, a CEE under the
foundation, dedicated to providing meaningful employment tailored to the
individual capabilities of its workers, with the goal of facilitating their
integration into the labor market.
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Strives to promote accessibility, digital skills
and employment opportunities for people
with disabilities in order to reduce the
digital divide and ensure their inclusion in
the rapidly evolving digital economy
influenced by the technological revolution
and the COVID-19 pandemic.
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The ongoing technological revolution and the accelerated
digitalization brought about by the COVID-19 pandemic are
reshaping the world of work. In response to the crisis, digital
measures have been instrumental, and it's clear that the future
of work will be increasingly digital. This makes the inclusion of
people with disabilities in the digital domain a critical concern.
The objective of this project is to minimize the impact of the
digital workplace on individuals with disabilities and to outline
actions for a more inclusive future of work. These actions
include ensuring digital accessibility, promoting digital skills
among people with disabilities, and encouraging their digital
employment.

Digital skills are in high demand, both in existing jobs and new
digital roles, but there is a lack of global data on the digital
skills of people with disabilities. Many individuals with
disabilities have lower levels of education and training, making
it vital for them to acquire new skills for accessing digital job
opportunities. Bridging the digital divide is crucial to ensuring
equal opportunities for people with disabilities in the labor
market. This commitment to inclusion is also reflected in the
2030 Agenda for Sustainable Development, emphasizing the
need to leave no one behind and explicitly addressing the
inclusion of persons with disabilities in various Sustainable
Development Goals.
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The digital transformation is rapidly evolving, significantly
impacting society, creating a growing "digital economy," and
influencing the entire workforce. However, it presents a dual
challenge and opportunity, particularly in ensuring that
individuals with disabilities are not left behind in this
digitalization process. The COVID-19 pandemic has amplified
the urgency of digitalization, further underscoring the need for
a targeted approach to address how it affects the inclusion of
people with disabilities in the workforce. This inclusive vision of
the future of work aligns with the 2030 Agenda and is essential
for upholding the rights and equal opportunities of persons
with disabilities. Achieving this vision requires the collective
efforts of governments, businesses, organizations, and
academia to create a future of work that benefits all, regardless
of their abilities or disabilities.
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In an age characterized by an ongoing technological
revolution and accelerated digitalization brought on by the
COVID-19 pandemic, inclusivity in the digital realm is more
crucial than ever. The DigitalPUSH Manual is a comprehensive
resource developed to support educators, professionals,
and volunteers who work with Individuals with
Disabilities (IDPs).

This manual serves as a valuable tool for those engaged in the
education and support of IDPs, offering both theoretical
insights and practical guidance. With the rapid integration
of digital technologies into various facets of society, it has
become imperative to provide tailored educational materials
to facilitate effective teaching and support for IDPs. The
DigitalPUSH Manual equips teachers, professionals, and
volunteers with the knowledge and skills necessary to
navigate the digital landscape and empower IDPs to do the
same.

Structured to promote accessibility, enhance digital skills,
and open up digital employment avenues for individuals
with disabilities, this manual addresses the evolving digital
landscape. As the demand for digital skills continues to grow,
particularly in the context of remote work and technology-
driven environments, this resource is an essential step
towards bridging the digital divide. By empowering IDPs with
digital proficiency, this manual seeks to contribute to a more
inclusive future of work and learning. 

INTRODUCTION
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MODULES
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MODULE 1

BASIC FOUNDATIONS
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What are they and what can we use them for?

New Information Technologies (NTI) are digital tools that help
us do many different things. They are things like computers,
phones, and tablets that allow us to communicate with other
people, find information, learn new things, and have fun.

Differences between mobile and computer

Mobile (smartphone): It is mainly used to make calls,
send messages and access the Internet.

It has a touch screen where you can tap and slide your
finger to interact with it.

You can use applications like WhatsApp, Facebook and
games on your mobile.

Computer (computer): It is a device larger than a mobile
phone.

It has a large screen and a keyboard for typing.

You can do many things with a computer, such as writing
documents, browsing the Internet, watching videos, and
playing more advanced games.

Information is saved and organized by folders.

1. NEW INFORMATION TECHNOLOGIES
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Uses and dangers of new information technologies

Communication: NNTT allow us to speak and write messages to
other people, even if they are far away. We can use
applications like WhatsApp or send emails to stay in touch with
friends and family.

Entertainment: NNTT offer us many ways to have fun. We can
watch videos on YouTube, listen to music on applications like
Spotify or watch movies and series on streaming platforms like
Netflix.

1. NEW INFORMATION TECHNOLOGIES
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It is important to be careful with our personal
information when using the NNTT. We should
not share personal data, such as our full
name, address, telephone number or
photographs of ourselves, with unknown
people or on untrustworthy websites, or click
on links or files that look suspicious.

CAREFUL! PHOTOS SHOULD NOT BE SHARED WITH
STRANGERS, OR ON UNRELIABLE WEBSITES

 NEW INFORMATION TECHNOLOGIES1.

Spending too much time in front of
NNTT screens can affect our health
and personal relationships. free.

IT IS IMPORTANT TO DO OTHER ACTIVITIES, SUCH AS
EXERCISING OR SPENDING TIME OUTDOORS!
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2. COMPUTER TOOLS

📋 Paste: Hold down the Ctrl key and press the V key.

✂ Cut: Hold down the Ctrl key and press the X key.

Keyboard shortcuts

📝 Copy: Hold down the Ctrl key and press the C key.

↩ Undo: Hold down the Ctrl key and press the Z key.

💾 Save: Hold down the Ctrl key and press the S key.
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Basic PC programs

🌐 Web browser: Explore the Internet and visit web pages.

📝 Word processor: Create and edit text documents.

🎵 Media player: Play music and videos on your PC.

2. COMPUTER TOOLS

13



Basic management tools on mobile devices and tablets

🔊  Sound settings: Control your device's volume and adjust
sound settings.

🔋 Battery Settings: Shows information about battery life and the
applications that consume it.

🌐  Wi-Fi Connection: Allows you to connect to available Wi-Fi
networks.

3. ANDROID/ IOS DEVICE TOOLS
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Basic apps for Android/IOS devices

📧  Email: Access your email account and send and receive
messages.

📊 Calculator: Perform basic mathematical calculations.

🗺Maps: Find directions and navigate maps.

🎵 Music Player: Play music and create playlists.

🎥 Camera: Take photos and record videos

3. ANDROID/ IOS DEVICE TOOLS
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MODULE 2

EMAIL
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Email is used to send and receive messages to other people.
For this, a person has an account and sends messages to other
people, with other accounts.

In them we can send texts, photos, videos, links to pages and
many other things.

It is very important that you do not forget that each email user
is unique, you cannot make a mistake or change any letter, or it
will not reach its recipient. And never use spaces!

Do you have an email?

Yeah
Go to the next section

No
Let's create one!

 1. WHAT IS AN EMAIL
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There are many types of email, here we will use one of the
best known as an example, that of Google, which is GMAIL.
This email will help us use many free tools later in this article.

Others can be hotmail, outlook, yahoo!, icloud and many more.

FOR THIS STEP YOU CAN ASK A TRUSTED PERSON
FOR HELP

2. LET'S CREATE AN EMAIL ACCOUNT

In our search engine, we write gmail, and we enter the
page that appears.

1.
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2. LET'S CREATE AN EMAIL ACCOUNT

1. We give the option to Create an account.

2. On the next screen we will enter our first name and a
surname, or fictitious name.

3. We will enter our date of birth or birthday, if we are a man
or woman, and we will click next.
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4. Now we must come up with a name for our account. This
name must be unique throughout the world, so you will
probably have to use numbers or extra letters.

 
Don't forget that you can't use spaces or some keyboard

symbols, such as accents.

5. Make up a password. Be careful, if you use capital letters,
accents or dots, they must always be the same.

6. Recovery email or phone number , so if you lose your
account or password you can fix it that way. Ask someone you
trust to use theirs, or use your number if you prefer.

7. You will have to accept the privacy policies and terms of
service , the rules so that you finally have your account.

8. You already have your account created.

2. LET'S CREATE AN EMAIL ACCOUNT

Reminder.

The password should be something difficult to guess, but
don't forget it. A good trick is to write your email account
and the new password somewhere safe at home, so that
it is never lost.
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We enter the page of our email account, remember that we
are using Gmail, but you can use others.

Write your email account. (Do not use spaces)1.
And the password. (Be careful not to have the SHIFT key on
accidentally)

2.

Once our account is opened, click on COMPLETE, or a + symbol
may also appear.

2. LET'S WRITE AN EMAIL

After clicking there, something similar to this screen opens:
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2. LET'S WRITE AN EMAIL

To - Here we put the email username of the person we are
going to write to, taking care that it is exact and without errors
or spaces.
Subject – It is like the name or title you give to the email. For
example, if you write to a friend it could be “say hello”, if it is for
a company it could be “my resume”, “math homework”.
Blank space – It is the body of the message, where we write
everything we want to say. REMEMBER that it is important to
use spaces, periods and commas to separate ideas.
Send – Used to send the email once you have finished it.
A – It is used to change the font type, the size, whether we
want it bold or underlined, and other changes.
Clip – Icon in the shape of a paper clip, with which we can
attach images, documents, videos and all kinds of things to our
email message as long as they do not take up too much digital
space (megabytes).

It is important to be polite, in addition to not
making a mistake in entering the email username, it
is good to start by saying hello and end by saying
goodbye.

And organize our ideas so that the other person
understands us better, separating them with
commas and periods.
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By clicking with the right button, we can correct this error
with some ideas that the computer gives us.

ATTENTION 

Sometimes when writing we make mistakes and
have spelling mistakes, they usually warn us and
put those mistakes underlined in RED.

2. LET'S WRITE AN EMAIL

In this example, requt corrects me, which does not exist,
and recommends that I change it to request. 
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2. LET'S WRITE AN EMAIL

    Lost emails

Sometimes when sending a message we receive an email
that says something like this:Separate text box

ADDRESS NOT FOUND

That is, the email address we have entered is not
correct and DOES NOT EXIST.

Remember that the accounts are very delicate, and
it is mandatory to write them as they are without
changing any letters or putting spaces.
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3. EMAIL FOLDERS AND TRAYS

Most emails are organized into similar sections, we call them
FOLDERS, and you can differentiate between those that have
been sent to you, those that you have sent, drafts, and other
options.

Again, we will use gmail email as an example to see some of
those functions.

Write – As we have already mentioned, it is used to write a
NEW email.
Received - Emails that have been sent to us appear here.
Some may be from advertising, or from the email itself that
tries to remind us or teach us things.
Sent - Those that we have sent to other people appear.
Drafts – Emails appear that we have started, but NOT SENT,
waiting for us to finish or delete them one day.
More - More functions and other categories appear here ,
such as “Trash” , those emails that we have deleted.
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3. EMAIL FOLDERS AND TRAYS

There are more folders or functions, and they may have
different names, but all email accounts work in a similar way.

New emails appear in a dark highlighted color, and with the
number of emails that you have not yet read on the left, in
the “Inbox Folder ”.

Once we open that email once, it will no longer be new, and it
will no longer be marked darker and will be one less number
on the “unread” list.
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4. DANGERS OF EMAIL

The Internet can sometimes be dangerous, do not forget that
we do not know who the person is on the other side of the
screen, if it is a man or a woman, a friend or someone who
wants to take advantage of us.

MESSAGES FROM STRANGERS

Sometimes we can receive emails from strangers, asking us
to click on a link, saying that they know you or that you have
won some prize and that you must accept something.

CAREFUL! They are emails that try to obtain your personal
information, steal information or money from you.

If we receive an email of this type, it is important to ask
another person before responding or clicking on anything.
Do not offer private information.

On the Internet there are many pages, emails or people who
can request our name, email, address or telephone number.
Do not give this information unless you believe it is
absolutely necessary.
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SIGN OUT OF OUR ACCOUNT

If we have accessed our email through a computer that is not
ours, we must "close the session", remove our account
before leaving so that no one else can enter.

We click on our profile icon, in the upper right, and then Log
out.

4. DANGERS OF EMAIL

REMEMBER  

For any situation in which we are unsure, it is better to
ask a family member, friend or trusted person.
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Google Drive is a tool that allows us to create text
documents, spreadsheets or presentations for free. And
everything is saved in our email!

It is a somewhat simpler and free alternative to what we
know as Microsoft Office.

It works by saving the documents that we have created, or
others that we can upload from our PC or electronic device,
within our own email account.

IMPORTANT

A GREAT ADVANTAGE is that we can access them from any
computer or device using our email.

Google email accounts (Gmail) include a very useful function,
being able to use Google Drive.

5. GOOGLE DRIVE
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CREATE A NEW DOCUMENT

To open a new document, click on New , and then choose the
desired document type.

The best known and most used are Google Docs,
Spreadsheets, and Presentations.

There are more advanced functions that we will not go into
detail in this manual.

WE WILL LEARN MORE ABOUT THIS IN THE NEXT UNITS. 
 

5. GOOGLE DRIVE
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What do I do if I accidentally or accidentally delete an
important email?

There is an area within the emails called “Deleted”, “Trash” or
something similar.
The emails that we have deleted stay here for a while, then
they delete themselves.

Do I have email in SPAM? What is it?

These are emails that are probably spam, misleading, or have
bad intentions. Sometimes an email from someone real
comes in, but if you don't know who it comes from, it's best
not to open them or download or click on anything they
have.

I don't remember my email or password, what do I do?

If you do not remember your email account or password, you
can try to recover it through the phone or email that you
have set as recovery or security.

It is important that we have added a phone number or email
of another trusted person, and this way we can always
recover our account if we have any problem.

QUICK QUESTIONS
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I receive many advertising or informative emails of some
kind, what can I do?

If you have many emails that you are not interested in from a
company, in those emails at the bottom they should have an
option that is "Cancel subscription", "Unsubscribe from
communications" or similar phrases.
If you click there, you should stop receiving emails from that
company.

I want to search for an email from someone or an email
that said something specific, how do I do it?

At the top is the magnifying glass icon, which you know so
well, and with which we can search for emails from specific
people or who have a specific word.

For example, you remember that a family member wrote you
an email talking about their vacation, and you try entering
the word “vacation” in the search engine.

QUICK QUESTIONS
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MODULE 3

INFORMATION
SEEKERS
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What is a search engine?

A search engine is a tool that allows you to find
information on the Internet. You can think of it as a kind of
virtual library where you can search for anything that
interests you.

The best-known information search engine GOOGLE

1. SEARCH ENGINES

Google is one of the most used search engines. You can
access it by typing www.google.com in the bar.

On the main page, you will find a search box where you can
type keywords related to the information you are looking for.
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1. SEARCH ENGINES

How to know if the information is reliable:

Not all the information you find on the internet is reliable. It is
important to know how to evaluate it. Here are some tips:

Verify the source: Look for information on reliable websites,
such as official or university pages.
Look at the date: If you see the date on the page, make sure
it is not too old.
Look for more sources: It is useful to find other pages that
talk about the same thing. This way you can compare the
information and see if it is true.

Efficient ways to search for information:

When using a search engine, there are some techniques that
will help you search for information more efficiently. Here are
some suggestions:

Keywords: Use keywords related to the topic you want to
research.
Use quotes: If you are looking for an exact phrase, put it in
quotes. This way the search engine will show you results
with that specific phrase.
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For example: ”sports cars”
Special words: There are words you can use to search better.

 
For example:

 "Or" means you can search for one thing or the other.
 "AND" means you look for both things together.
 "NO" means you want to exclude something.

Tools within the Google search engine:

Within the Google search engine, there are some tools that can
help you find information more precisely. Here are some of them:

Search Filters: After performing a Google search, you can use the
filters located below the search bar to narrow your results. For
example, you can filter by content type (images, videos, news), by
date, or even by region.

Google Images: If you are searching for images, you can click the
"Images" tab on the Google results page to see images related to
your search. You can click on an image to see it full size and learn
more about it.

2. GOOGLE
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Voice search tools:

Google also offers the option to perform voice searches on
mobile devices. Here's how to use this feature:

Open the Google app on your mobile device.
In the search bar, you will see a microphone icon. Tap that icon
to activate voice search.

Say out loud what you want to search for. You can say a
keyword or ask a question.
Google will process your voice and display the results on the
screen. You can tap the links to get more information.

Google on mobile devices:

Google is available on mobile devices, which makes it easy to use.
You can download the Google app from your device's app store.

Once the application is downloaded, you can access the Google
search engine and use all the functions mentioned above,
including voice search. Remember that voice search can be very
useful.

In this manual, we will learn about text editors, how they can help
us, and explore some basic tools. We will also address basic
spelling and grammar rules. Let's get started!

2. GOOGLE
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MODULE 4

TEXT EDITOR
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What are text editors and what are they used for?

Text editors are computer programs that allow us to create, edit
and save written documents.

They are like a sheet of digital paper on which we can write,
correct and format the text.

They are used to write letters, essays, stories and any type of
written document.

How can text editors help us?

Text editors can be very useful for us. Here are some ways you
can help us:

Ease of writing: We can write in the text editor using the
computer keyboard, which can be more comfortable than
writing by hand.

Error correction: Text editors help us detect spelling errors
and suggest corrections. This helps us improve our writing.

Text organization: We can organize our text using
paragraphs, titles and lists. This makes it easier to read and
understand.

Text formatting: Text editors allow us to format text, such as
changing the size and font, highlighting words, or adding
images. This makes our documents more attractive and
easier to read.

1. TEXT EDITOR
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Basic tools of text editors:
Within text editors, we find basic tools that help us work with text,
for example, cut, paste, undo, format, etc., some of them we will
see later.

Basic spelling and grammar rules:

When we write in a text editor, it is important to follow some basic
rules of spelling and grammar. Here are some tips:

Spelling: Pay attention to the correct writing of the words. Use
the text editor's spell-checking tools to help you catch errors.

Punctuation: Correctly use punctuation marks, such as periods,
commas, and question marks. This helps make the text clear
and understandable.

Capitalization: Use capital letters at the beginning of a sentence
and in proper nouns. Use lowercase letters in the rest of the
text.

Agreement: Make sure that nouns and verbs agree in number
and gender. For example, if you have a plural noun, the
accompanying verb must also be plural. Likewise, if you have a
feminine noun, use feminine adjectives and articles that agree
with it.

1. TEXT EDITOR
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Proper use of accents: Pay attention to the words that have an
accent and place them correctly. Accents can change the
meaning of a word, so it is important to use them
appropriately.

Use of question and exclamation marks: Use question marks (?)
and exclamation marks (!) at the end and beginning of
questions and exclamatory sentences, respectively. These signs
help convey the tone and intention of your sentences.

In the next point we will give you some tricks to correct your
spelling mistakes.

Remember that you don't have to worry if you make some
mistakes while writing. Text editors are there to help you correct
them. It's also a good idea to ask an adult or someone close to you
for help if you have questions about spelling or grammar.

1. TEXT EDITOR
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In this manual, we will learn about Microsoft Word tools, how to
edit documents, and how to save and manage files. Microsoft
Word is a widely used word processing program that allows us to
create and edit documents.

How to access Word?

Normally, all computers have the Microsoft package installed,
which includes Word, Excel and Power Point.

Click the Home button or navigate to the search bar at the
bottom of the screen.

In the list of applications, find Word and click it. The Start screen
appears and Word starts .

Word tools

Microsoft Word offers several useful tools for working with
documents. Here are some of them:

Toolbar: At the top of the screen, you will find a bar with
different options and buttons. These tools allow you to
format text, insert images, change the document layout, and
much more.

2. MICROSOFT WORD
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Text format

You can change the font, size, color and style of the text using the
text formatting options. You can also highlight words or
paragraphs with bold, italics, or underlining.

Bold, italic and underline: 

These options allow us to highlight important words or phrases in
the text.

Find the text or word you want to bold, italicize, or underline .
Scroll through your document until you find the text or word you
want to bold, italicize, or underline.

Select it with the mouse : When you select it, a box will appear.

Click:
 About the “N” if you want to put it in bold.a.
 About the “K” if you want to put it in italics.b.
 About the “S” if you want to underline it.c.

2. MICROSOFT WORD

43



Change font style, size and color

This option allows us to choose the design of the letter that we like
the most, its size, that is, enlarge or reduce it, and even the color.

With the mouse, position yourself over the word or text you want to
change. Next, the same box as before will open.

To change the font style: click with the cursor on the first rectangle
at the top left

Next, all the letter models that Word has will be displayed. Choose
the one you like the most by clicking on it. At that moment you will
be changed to the chosen format.

To enlarge or reduce the size of the letter: Click on “A” and it will
become larger, or on “ A ” and it will become smaller.

Another way to choose the font size is by clicking on the box where
a number appears. The letter sizes will be displayed and you just
have to choose the one you want.

2. MICROSOFT WORD
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Insert images

You can add images to your document by clicking the "Insert" tab
and selecting the "Image" option. This allows you to add
illustrations, photographs that are on your computer to your
document.

If you want to insert photographs or images online, you will have to
choose the “online images” option. A box will open with a
magnifying glass and there you must write the image you want to
insert.

If you choose, for example, the word “monkey”, this will be the
result:

2. MICROSOFT WORD
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Insert tables:

Tables are useful for organizing information into rows and columns.
You can insert a table by clicking the “ Insert ” tab and selecting the “
Table ” option. You can choose the number of columns and rows in
the table, adjust the size of the cells, and add content to them.

Document editing

Microsoft Word allows you to edit your documents in several ways.
Here are some editing options:

Copy, cut and paste: You can copy text or an image by selecting it
and using the "Copy" and "Paste" options in the toolbar. You can
also cut the text or image to remove it from one location and then
paste it to another.

Copy and paste : We can copy text from one place and paste it in
another. This helps us reuse information and save time.
Find the text you want to copy . Scroll through the document
until you find the text you want to copy.
Highlight the text . To highlight text, left click and then drag the
mouse pointer over the text you want to copy.

2. MICROSOFT WORD
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Copy the word(s). Once you've highlighted it, right-click and
choose “Copy” from the options that appear.

Then go to the place where you want to copy it.
Paste the word(s) . Right-click and choose “paste” from the
options that appear.

Cut and paste: You will use the option to cut a text or a word when
you want to change its location. To do this you must:

Find the text or word you want to cut . Scroll through the
document until you find the text you want to cut.
Highlight the text or word . To highlight a text or word, left click
and then drag the mouse pointer over the text you want to cut.
Cut the word(s). Once you have highlighted it, right click and
choose “ Cut ” from the options that appear

Then go to the place where you want to put it.

Paste the word(s) . Right-click and choose “paste” from the options
that appear.

2. MICROSOFT WORD
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 Search for and replace:

If you need to find a specific word or phrase in your document,
you can use the "Search" function in the "Home" tab. You can also
replace one word or phrase with another using the "Replace"
option.

Automatic correction:

Word can automatically correct spelling and grammatical errors
as you type. Words underlined in red or green indicate errors or
suggestions for correction. You can right-click on the underlined
words to see the correction options and change them directly.

Save and manage files

It's important to save your work regularly so you don't lose any
changes you've made. Here are some steps to save and manage
your files:

Open a document:

Once you are inside Word, you will initially enter the screen where
you must choose whether you want to create a new document or
load one that you have on your computer. To create a document,
you have a bar above where you can choose whether you want it
to be a blank document or one based on a template.

2. MICROSOFT WORD
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To create a new document you must click on Blank Document.

Here a blank page will open where you can start writing.

If what you want is to open a document that you already have
saved on your computer, when you enter Word, on the left side you
will see the list of the last files you have opened. You can choose
one from there, or if it does not appear, at the end of the list
appears “open another document”, by clicking here you can locate
it on your computer.

Save a document

When you have created a new document and want to keep it on
your computer, click on the “FILE” box at the top left of the screen
and a menu will appear on the left. You must choose the “save as”
option.

2. MICROSOFT WORD
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Next, another screen will appear, where you will have to choose
where to save it (it can be on the computer, on the desktop, etc.)
Normally, you will save it on the computer.

2. MICROSOFT WORD

Once you have chosen the place, another screen will appear where
you will have to name the document, that is, what you want to call it.

Once you have named your file, you must click on the word “save”
and it will be archived on your computer.
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Manage files:

You can organize your files in folders to keep them organized. You
can create new folders, rename files, and move files to different
locations on your computer. This will help you find your documents
easily when you need them.

2. MICROSOFT WORD

For example, if you have several assignments for the English subject,
you can open a folder called “English assignments” and put all the
assignments for that subject in that folder. This way everything will
be more organized and it will be easier for you to find your
documentation.
You can also transfer files from one folder to another. You will have
to do it with the “cut and paste” option as we have shown you
previously.

Print documents: 

If you want to print your document, you can click on the "File" tab
and select the "Print" option. There you can adjust print settings,
such as:
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The number of copies, you must specify if you want to make
one or several
The orientation of the page, you must specify whether you
want to print it horizontally or vertically
The printer you want to use, if you have several printers
configured on your computer, you must indicate which one
you want to use at that moment.

Backups

Remember that it is important to make backup copies of your
important documents. You can save copies to external storage
drives, such as USB sticks or external hard drives, or use cloud
services to store your files securely.

The copies are made in the same way that we have taught you
previously, the only thing you would have to do is choose the
important files, copy them and paste them on the USB or external
hard drive.

2. MICROSOFT WORD

Once you insert the USB into your computer it will appear as in
the image.

Use attractive visuals to make it easier to express your message.
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MODULE 5

SLIDE EDITOR
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 What are they and what are they used for?

A presentation editor is a computer application that allows you
to create attractive presentations easily and quickly. A
presentation typically has a series of slides displayed in
sequential order.

How can they help us? What are slide editors?

A Presentation Program is software used to display information
normally outlined on one or more slides. They are very useful in
oral presentations, being used to transmit information to a
person or a group. They allow us to organize information: ideas,
data, results, plans, etc.

1. SLIDE EDITORS
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A slide in PowerPoint is each of the digital sheets that form a
presentation in which you can add text, images, photographs,
videos, graphics, animated gifs , etc.

Power Point Tools

How to access Power Point?

Normally, all computers have the Microsoft package installed,
which includes Word, Excel and Power Point.

1. Click the Start button. or go to the search bar at the bottom of
the screen.
2. In the list of applications, find Power Point and click on it. The
home screen appears and Power Point starts.

2. MICROSOFT POWERPOINT

This image will appear. If you want to create a new presentation,
you will have to click on “ blank presentation ”.
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You can also use any of the templates that the application
suggests. In this case, if you choose one, you can base it on it, but
make the changes you see fit. For example, font size, background
color, and including other information, etc.

To create a blank presentation:

- We will display the File tab
- We will select the New option
- In the blank Presentation dialog box press the Create button.

This is how to create a blank presentation.

2. MICROSOFT POWERPOINT

The central part of the window is where we will create the
different elements of the pages or slides, and all of them will
form the presentation.

We will have a blank presentation, being the first slide it proposes
a
design with two text boxes to add a title and subtitle , known as
Title Slide , design that we can change ( right button, design ).
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Here you can choose the type of design you want to give to your
slide.

For example: To fill in the title, you would have to position
yourself where it says “click to add title” and enter the title of
your presentation. Here you can choose the font, its size, color,
etc., in the same way as you do in Word.

If you do not want to put a subtitle, you would have to position
yourself over the box and click delete.

When you have finished the first slide, to add a new one you
must click on new slide and start working on the second page of
your presentation.

2. MICROSOFT POWERPOINT
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Here you can choose the type of design you want to give to your
slide.

For example: To fill in the title, you would have to position
yourself where it says “click to add title” and enter the title of
your presentation. Here you can choose the font, its size, color,
etc., in the same way as you do in Word.

If you do not want to put a subtitle, you would have to position
yourself over the box and click delete.

When you have finished the first slide, to add a new one you
must click on new slide and start working on the second page of
your presentation.

2. MICROSOFT POWERPOINT
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Insert

As in Word, you can insert images from your computer or from
the Internet, tables, graphs, etc. It is done exactly the same as in
Word.

If you want to include a Google image, you will have to position
yourself over the image and right-click on “copy image”, then go
to your slide and right-click “paste” and it will appear on the
slide.

If you want to resize the image, click on it and a square will
appear on the edge with some small circles in the corners. Place
yourself over one of them with the mouse and drag it, you will
see how the image gets larger or smaller depending on the
movement of the mouse.

2. MICROSOFT POWERPOINT
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Design

Within the design we will include several sections:

Format text

1.     Select the text you want to give a specific format to.
2.     Under Drawing Tools , choose Format.
3.     Follow each of these procedures:

To change the color of the text , you have to click on Text Fill
and choose a color .
To change the color of the text outline , you have to click on
Text Outline and choose a color .
To apply shadows, reflections, highlights, bevels, 3D rotations
or transformations , you have to click on Text Effects and
choose the effect you want to apply.

2. MICROSOFT POWERPOINT

Change font on a single slide

To change the font for a single paragraph or sentence, select the
text you want to change.
To change the font of all placeholder text, select all placeholder
text.
On the Home tab, in the Font group , select the font you like best
from the Font list.
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Here you can choose the color of the background, if it has
transparencies or if it is gradient, etc.

Transitions

Slide transition is the visual effect that plays when you move
from one slide to the next during a presentation. You can control
the speed, meaning that they pass more or less quickly, add
music or sound, and customize the properties of the transition
effects.

For example, you can create a 'fade in' effect so that the old slide
fades in and out replace with a new one, or make one slide
appear to 'push' another out . When you add a transition effect
to a slide, the transition effect occur between the previous slide
and the selected slide.

You can also add sound effects to your transitions, but to do this
you will have to have a sound card and speakers to reproduce
sounds.

2. MICROSOFT POWERPOINT
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Animations

PowerPoint animations are visual effects for objects that appear
in your presentation.

Animations are used to bring objects such as text, images or
graphics on and off your slide.

Select the slide object you want to animate. On the “Animations”
tab, click Animation Panel. Click “Add Animation” and choose an
animation effect. To apply other animation effects to the same
object, you can select it, click “Add” and choose another
animation effect.

2. MICROSOFT POWERPOINT

Slide presentation

To start the presentation on the first slide, in the Start Slide Show
group , click From Beginning.
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The Review tab will allow you to add comments, run a spell
check, or compare one presentation to another (for example, a
previous version).

View

If you're not on the first slide and want to start from where you
are, click From current slide.

Review

2. MICROSOFT POWERPOINT

Views allow you to view your presentation in different ways
depending on where you are in the creation or delivery process.

63



Slide editing

Save and manage files

1.On the File tab, click Save.
2. Choose a folder or navigate to it.
3. In the Name boxfile, type a name for the presentation, and then
click Save.

2. MICROSOFT POWERPOINT

Tips for creating an effective presentation

When you give a presentation you will have to take into account
the following suggestions to keep the audience interested.

The number of slides should not be too large1.
To keep the message clear and the audience attentive and
interested, the number of slides in the presentation should
not be very high

2.

Choose a font size that is easy for users to read3.
The text on the slide should be simple, easy to understand4.
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MODULE 6

SPREADSHEETS 
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Spreadsheets are used to record information, make lists of
things, or do accounts.

You can do anything, it is a more formal and working document
in the business world, more so than Documents or Presentations.

Remember: Google Spreadsheets are very similar to others you
may know like Microsoft's Excel , OpenOffice Spreadsheets , or
Apple's Numbers.

1. SPREADSHEETS 

REMEMBER

You can open these documents from Google DRIVE , and
then we open Google Sheets

What are spreadsheets like?

Spreadsheets have a very striking shape, they are divided into
rectangles, which we call cells.

If it helps you remember, imagine like jail cells!
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To move around Excel, we have to remember that it is divided
into rows and columns.

Rows are called the line that goes from one side to the other.
They are organized by LETTERS.

Columns that go from top to bottom. They are organized by
NUMBERS.

1. SPREADSHEETS 

If it helps you remember, you can think of a ROW of people one
after another, or a column of a building to remember that they go
from top to bottom.

To move around Excel, we have to remember that it is divided into
rows and columns.
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How do we move around the spreadsheet?

We can move around the sheet with the mouse , clicking on the
cell we want to write.

We can also use the arrow keys on the keyboard.

2. MOVING AROUND THE SPREADSHEET

Join cells

We can join two or more cells and make it just one, by clicking on
the ”Combine Cells” button, which is on the toolbar. 

If we want to separate several cells that are already combined,
we click on that button again.
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How do we move around the spreadsheet?

If we have made a mistake or done
something wrong, we can press Undo.

If we want to recover something that we have
deleted when going back, press Redo.

2. MOVING AROUND THE SPREADSHEET

Expand the size of ROWS or COLUMNS

Sometimes what we want to write is larger than the available
space, in that case we can expand the size of the row or column.

We use the left click of the mouse on the corner that you want to
enlarge or “stretch”, and we enlarge as much as we want.

If you want to expand ROWS , we enter the number we want to
expand.

For example, if you want to expand 1 , we place them between 1
and 2 and expand.
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If it is in COLUMNS , we enter the letter that we want to
expand.

For example, we place ourselves between A and B , and
lengthen A.

2. MOVING AROUND THE SPREADSHEET

Sheets

The document is divided into sheets, on each sheet you can
write different information.

For example, on one sheet you can make a shopping list for a
party, and on the next sheet the guests for the event.

To create a new sheet, click on the +.

If you want to delete, rename, copy the sheet, or other
functions, you must right-click on “Sheet1” or whatever name it
is.
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What can I write in a spreadsheet?

You can do anything, it is the main document used in
companies, more than presentations or Google documents.

They are used to make lists, accounts and formulas.

Spreadsheet formulas

This is the most difficult part, spreadsheets are used to do
complex mathematical operations.

To see the available functions, you must go to a cell “formulas”,
and in the upper tools click on Insert Function.

2. MOVING AROUND THE SPREADSHEET
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You can do these operations using the symbols directly in the
cell.

You choose the cell where the results will be seen1.
We put the symbol =2.
We click on the first cell that has the data3.
We use the operation symbol. For example, the above + - *
/

4.

We click on the next cell that has the data.5.
We press the Enter key for the operation to be carried out.6.

2. MOVING AROUND THE SPREADSHEET

REMEMBER:

If an error message appears, it means
that there is some step that we have
not done correctly. Let's start again!
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MODULE 7

CANVA
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What is Canva?

Canva is like a computer program that helps you be
creative and make beautiful things. It's like having an art
studio on your computer or tablet.

1. CANVA

Canva has many other functions such as creating cards,
posters , brochures, images for social networks... It has
templates that you can customize with colors, text and
graphic elements.
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To start using Canva we have to register with our email, or
click continue with our Google or Facebook account.

1. CANVA

Once we have accessed, in the blue square we select the type
of design we want to make.

Additionally, in the search engine we can enter what template
we are looking for. For example we put: resume, and press the
enter button on our keyboard
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Now, we choose what type of template we want to use and
click customize template.

1. CANVA

And we edit it to our liking.
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To save our jobs:
Click on the top right where it says share.

1. CANVA

On the right we find a menu.

Home: is the main page
Projects: you can find all the jobs you have done
Templates: different templates appear
My brand: Be careful, it's a Premium feature
App: You can make different documents for applications,
such as creating QR codes.
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This file will be saved in the downloads folder on our computer
and automatically in Canva.

In Canva we can find it in the menu that we explained
previously in the “projects” section.

1. CANVA

We press the download button and choose the type of format
we want.
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MODULE 8

FINAL
RECOMMENDATIONS
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But it also has its dangers, and can bring us very serious
problems.

One of the most striking aspects of the internet are SOCIAL
NETWORKS.

Some recommendations for its proper use are:

1. FINAL RECOMMENDATIONS

The Internet is something that has offered us many
opportunities, such as searching for information of all kinds,
being able to talk to people from a long distance or having fun
in many ways.
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DO NOT POST INTIMATE OR PRIVATE IMAGES
It happens when we post photos or videos with little clothing or
publish everything we do at all times. If it's something not
everyone can see, don't share!
We can get into legal trouble if we share other people's photos
without their permission, download illegal things, etc.
If it's something not everyone can see, don't share!

BE CAREFUL WITH WHAT YOU WRITE
Don't argue, criticize or make bad jokes. What you write stays
there.

DO NOT ACCEPT STRANGERS ON YOUR SOCIAL
NETWORKS

Do not confuse social networks with real friends, you do not
know what that person is like, what their intention is, who will
be able to see your photos or videos through that person, etc.

DO NOT PUT PRIVATE PERSONAL DATA
Do not write or show where you live, phone numbers, ID or
cards of yourself or others. It is also not advisable to say when
you are alone at home, or you are going on vacation and your
house is empty.

USE A “PRIVATE PROFILE”
All networks have systems to set your “Private Profile” so that
only your friends can see your posts. This way you can prevent
people with bad intentions from seeing you.

1. FINAL RECOMMENDATIONS
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DON'T BELIEVE EVERYTHING YOU SEE
There are many fake news that can make us feel afraid. Many
famous people who publish.
Don't trust everything you read.
There are many people with fake accounts, unrealistic contests
that ask you for personal information, applications that
promise to tell you interesting information in exchange for your
username and password, etc.

IF YOU HAVE QUESTIONS, ASK SOMEONE YOU TRUST
On the internet and on social networks, there can be many
situations that make us doubt if we are doing something right.
If you find yourself in that situation, ask a family member.

THE TIME YOU DEDICATE
Sometimes we spend too much time on social networks and
put aside other plans with friends and family.
Social networks can cause addiction.

THINK BEFORE YOU PUBLISH
We must think about what we do and that many people can see
it, always think first.
If you're worried about someone seeing what you've posted,
that's not something we should post!

1. FINAL RECOMMENDATIONS
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